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The cover photo, “Jackson,” was created 
by Cliff Ranson of McAllen, Texas. The 

dog was a roadside rescue and was 
brought to Cliff’s studio by a college 

student during an animal shelter benefit 
in which Cliff participates each year. The 
image won the Trophy for Best Portrait 
of an Animal, the ASP Elite Award, and 
Best Photographic Open by a Master. 
“Jackson” is now part of the PPA Loan 

Collection as well.
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It’s hard to believe that my year as President of Texas PPA is drawing to 
an end. It’s been a highly productive year beginning with PhotoGenesis 

in January. We moved this annual event to San Marcos, Texas, and gave it 
a face-lift designed to renew that excitement we all had at one point in our 
lives when photography was magic. It included on-location workshops  with 
plenty of hands-on activities. The event and the location proved to be so 
popular that we will return again in 2016!

Next on the calendar was the fabulous Texas School of Professional 
Photography held in Addison, Texas. When over 1,000 photographers get 
together for a week of fun and learning, it is an experience that you can only 
understand if you’ve been there. This school is the largest of its kind in the 
nation and I’m proud to be a part of it.

Another major change for the year was the Texas PPA summer seminar. For 
decades, this event has been held in Kerrville, Texas. This year, the event 
was given a face-lift and moved to Conroe, Texas. Summerfest 2015 turned 
out to be an outstanding experience with something for the entire family and 
surpassed all our expectations. Yes, we’ll be returning there in 2016 as well.

As I write this message, we are also in the middle of the Texas 10 
Workshops. This fall event was the brainstorm of Steve Kozak, who is the 
incoming TPPA President for 2016. These workshops are being held at 

various locations throughout the state. This is the second year for these fall 
workshops and they are a great opportunity to attend an incredible program 
close to your home location.

Providing all of these events to you as a TPPA member is no small task. It 
takes a lot of teamwork and dedication. I want to thank everyone who gave 
of their own time to serve on a committee for any or all of these events and 
I want to thank the TPPA officers and staff for the countless hours of hard 
work each one has given to make this association what it is today.

Your incoming TPPA President, Steve Kozak, is one of the most capable 
and energetic individuals I’ve ever met and already has a fantastic lineup of 
talent for the coming year. Everyone has done their part to make this “your” 
association and all that is left is for you to take advantage of everything it 
has to offer. It has been an honor to be your President.

So... keep in focus,

Stephanie Huebinger Ludlow,  Master Cr. Photographer
Texas PPA President 2015

Membership Categories & Rates

Professional Active $95 - Open to photographers and employees of 
photographers who sell photographic services as a business and photographers 
employed by a firm whose main business is selling photographs. State Law 
requires that all such individuals hold a Texas Limited Sales Tax permit.

Limited Associate $85 - Open to individuals seriously interested in photography 
and are engaged in an occupation other than photography.

Student $50 - Open to full time students preparing for a career in photography, in 
a college or approved vocational/technical school. 		

Service Firm $90 - Open to manufacturers, suppliers, laboratories and 
businesses supplying photographers; includes one person’s membership. 

Staff Associate $55 - Open to individuals employed by a Professional Active 
or Service Firm member or the spouse of a Professional Active member. Staff 
Associate membership may be accepted only if employer is current member.

Out of State $65 -  Note: Only Professional Active members have all 
membership rights. Spouses of Professional Active members are exempt from 
dues, unless they elect to become a Professional Active member in order to vote or 
exhibit prints. Limited Associate, Out of State, Student, Service or Staff Associate 
members may not vote, hold office or enter photographs in competition, unless a 
special category has been established for them.

What an Incredible Year!
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Sneak peek:  n. A preview, especially of something not yet public; 
an opportunity to see select portions before it is officially available 

(not to be confused with sneak preview). “I Just saw the sneak peek on 
Youtube.”

Ok, so this is from the “Urban Dictionary” and I am not sure of the accuracy, 
but it should work for the purposes of this article.  I am a huge proponent of 
social media for the purpose of elevating the clients experience or building 
anticipation in your process.  That being said, it is my opinion that far too 
often image-makers reveal too much of the magic prior to the client’s order 
appointment. But if used correctly, social media is also a perfect way to help 
flame the “Buzz Fire” and add to your toolbox of institutional marketing 
solutions.  So how much is too much and where is the line of not enough? 

Every family has their unique special stories that are often shared during 
special occasions.  My brother taught me many skills growing up but one that 

Gregory Daniel 
FDPE, FSA, M.Photog. CR., CPP, F-ASP

stands out at the moment was the ability to completely open our Christmas 
gifts without any parental detection.  He could remove wrapping paper like 
a skilled heart surgeon.  Our parents would begin the tedious process of 
wrapping all of our presents weeks and weeks before Christmas and neatly 
place them under the tree.  This is what I would call “building the experience!”  
Nightly, we would listen to Christmas music while sipping hot chocolate trying 
to guess what was in each box.  Shaking, sniffing, tugging, hypothesizing and 
dreaming about the items we asked for during the year.  

The special holiday experience began to shift the year we were able to crack 
the wrapping code of ethics.  I remember my brother unwrapping a pair of 
boots and his new tassel jacket (please refrain from obvious inclinations of 
judgment) and wore them to the mall.  He was able to pull this stunt off and 
get the items back into the boxes with stealth and perfect wrapping.  The only 
actual flaw in this otherwise brilliant strategy was our inability to act truly 
surprised on Christmas day.  
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I tell you this story because much of our holiday experience is the 
anticipation for the actual event.  You see, knowing what is in the box 
actually takes away from our overall experience.  There are many ways 
we use anticipation to add to our client’s overall experience.  In fact, we 
have found that using this principle of anticipation dramatically heightens 
their experience and boosts the buzz factor.  Let’s take a closer look at 
anticipation…

Anticipation: n. The feeling you feel when you feel you’re going to 
feel a feeling you’ve never felt before. “I can’t wait... for my tax refund, 
for this day to end, until they get here. The anticipation is killing me!”

There are many elements we add to build client value and experience during 
each client touch point, but for this message, I will just touch on one very 
important area.  If you are like me, you know when the magic is taking place 
during the camera study.  I certainly make it known through my excitement 
when this is happening.  If you have ever taken one of our classes before, 
you should be shaking your head up and down with total understanding.  
This is a perfect time to give your clients a sweet, quick look at the back of 
your camera.  That little glimpse is just enough to build their anticipation of 
what’s to come. 

We have also taken to a practice that involves Lesa capturing an image of 
me during the camera study with the client, using my camera on my iPhone.  
This image capture is not intended to be a stunning image for printing 
or used as one of their portraits. Its sole purpose is to grab a piece of the 
experience and the emotions of the event for the client and post it.  Posting 
an image that represents what they felt during the camera study builds their 
excitement, which typically plays out in the social media world.  

We have found that using anticipation principles are far better than 
unwrapping the present prior to the appropriate reveal moment.  I am certain, 
as much as my brother and our clients would like to know what exactly is in 
that box, that knowing is not always what is best for everyone involved!

  Greg and his wife Lesa Daniel are internationally recognized for their 
artistry. Though he is one of the most awarded photographers in the United 
States, Greg has the utmost privilege of living out his passion every day 
alongside Lesa in operating their portrait photography galleries in both 
Indialantic and Titusville, Florida. He has achieved both the title of Master 
of Photography and The American Society of Photographers Fellowship. In 
addition, Greg is was one of the youngest members to be inducted into the 
prestigious Cameracraftsmen of America in 1991, proud founding member 
of the International Society of Portrait Artists (ISPA) and on the Board of 
Directors for Professional Photographers of America.
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“Elementary My Dear” - Melinda Reddehase, of Spring, Texas, loves the process of working on images for print competition. “It allows 
me to think through an idea and plan each detail,” she explains, “which is something I rarely get the luxury of doing in my day to day 
studio work.” The inspiration for this image was, of course, Sherlock Holmes. The subject was photographed on a grey background in 
Melinda’s studio and each element of the final image was composited around him. The fireplace is five images combined. The chairs, 
wall sconces, smoke, and even facial hair was added in post production. The room was originally photographed in daylight with one wall 
being windows. The image was accepted into the PPA Loan Collection.

Melinda Reddehase, M.Photog.Cr., has a Bachelor of Arts Degree in Photography from Sam Houston State University. After graduation, 
she opened her own studio and was, for a time, the youngest studio owner in Texas. Her sister, Cristie, joined her full time at the studio 
two years later and they have been an amazing team for over 14 years. Photographing seniors, babies and fine art photography are her 
first loves. Recently, she has taken her talent for lighting and composition to enter the world of fine art cinematography. Frequent work on 
movie sets and high-end cinematography for studio clients has become a new and exciting adventure for her. 
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In most cases, window light is a soft, diffused light unless the sun is coming directly through the window. For this article we will focus on the former. The 
reason window light works so well is its light quality. To re-create the window light look, you must first understand why the quality is what it is. 

Light quality all goes back to size of source relative to the distance from and size of subject. Simply stated, the larger the source, the softer the light quality. 
Keep in mind that softness of light is determined by the transition from highlight to shadow, the shadow edge transfer. Do not confuse density of a shadow 
with light quality. It is easy to see very rich, dark shadows and think it is hard light. So, if we understand that size matters, we can then begin to create a 
source that will look like and act like window light. You will need a large source. I have used 4x6 boxes, 5’ Octabanks, umbrellas and even used multiple 
modifiers to create a large source. Some were successful in re-creating window light looks, other were not. In most instances I still needed a larger light 
source. 

I began using a 9x12 foot painter’s dropcloth that I found at my local hardware store. It is very, very affordable ($9 for two), easy to transport and to set up. 
Simply unfold the cloth and clamp it to a background stand or between two light stands. Place a strobe or speed light behind the cloth (see diagram 1 on 
page 15). Keep in mind that the farther the strobe is behind the cloth, the softer and more efficient your source will be. 

Cris j Duncan 
M.Photog.Cr. CPP F-TPPA

Window light has to be one of the most beautiful light sources we can use. It has a soft direction of light, can be easily 
manipulated by moving your subject closer or farther away. It covers a large area and is free... if you have a window. 

What if you don’t have a window? You make one. 



The idea is to eliminate the hot spot. The farther the light source can be 
from the cloth, the more diffused and even the transmission of light will 
be once it hits the dropcloth. You now can easily change the light direction 
by rotating the cloth, changing strobe position, moving your model or your 
camera. You now have “window light” anywhere. I have used this in clients 
homes, the studio, and even on commercial/architectural assignments.  

I want to continue with another technique for no-window, window lighting 
in a slightly different direction. Once again, remember that you must 
understand the principle of size of source. This is crucial to creating the look 
you want and need. 

The tools for creating light are many but they all can be confined to a few 
categories: Daylight (The sun), Ambient (Available Light), Electronic burst 
(Flash or strobe) and Continuous light (LEDs, HID, Video lights). These 
tools can be used in many ways but they can also be simplified... direct, 
additive, subtractive, transmission, and reflective. 

Previously, we created window light with electronic burst and a 
transmission technique. For this second example I want to create the same 

look but with a 
reflective approach. 
To create a soft, low 
contrast, directional 

A painter’s dropcloth 
with a strobe or 
speed light placed 
behind makes a 
very affordable 
light source which 
simulates window 
lighting.
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light, I need a 
large source. 
In this case 
all I had at 
my disposal 
were my 
studio strobes, 
an umbrella, 
3x4 soft box 
and a studio 
space. When 
my model was 
wanting a soft, 
dreamy look for 
her maternity 
image, I knew 
I needed a 
window light 
look... a larger 
source. I used a 
white wall that 
was in the studio and two strobes. The strobes were directed at the wall and 
then reflected back to my subject (diagram 2 above). 

The use of reflective light turned the entire wall into a light source. In turn, 
it provided a light source that produced a soft, pleasing light quality. I was 
able to create window light without a window.  

A photographer is a “problem solver.” Every photographic assignment will 
come with its own set of challenges. It is our job to find a way to give the 
client the image they need regardless of the situation and it usually starts 
with light. This all worked because of the science of light and that is what 
makes it so amazing. Light will always do the same thing because it is 
governed by science and laws of nature. It is predictable and reliable. 

Diagram 1 - Light setup using painter’s drop cloth in a home or studio 
setting to simulate window lighting.

Cris Duncan owns and operates CjDuncan Photography, a portrait 
and commercial studio in Lubbock, Texas, with his bride, Deanna. 
The Duncans are instructors at the Texas School of Professional 
Photography and the founders of  Find Your Focus Photographic 

Education. www.findyourfocus.org

Diagram 2 - Light setup where strobes are bounced off a white wall or 
background to simulate window lighting
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“In Flight Meal” is a composition 
of two photographs taken by Janel 
Randall while on two separate 
vacations. It is truly an international 
print. The hummingbird, a female 
calliope, was photographed in Canada 
with a Nikon D2X. A feeder was used 
to lure the birds into a 3 off-camera 
flash setup used to stop the wing 
action. The flower, a white oleander, 
was photographed in Mexico with a 
point and shoot camera and the color 
was later changed to pink in post 
production. The final composite was 
created in Photoshop and Janel used 
Corel Painter to express her fine art 
style for the finished print. Janel has 
had several prints selected for the IPC 
Loan collection, and will be awarded 
the Master of Photography degree at 
Imaging USA in January 2016. 
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Mike & Suzy Fulton 
Joel Grimes		
Jeff Gump		
Russ Harrington		
John Hartman		
Jamie Hayes & Mary Fisk-Taylor
Elizabeth & Trey Homan
Julia Kelleher		
Britney & Kirby Fullgraf		
Laurie Klein & Kyle Perler
Steve Kozak		
Don MacGregor		

41st Annual Texas School 
April 24 - 29, 2016

by 
Don Dickson

The 2016 Texas School of Professional Photography will once again be 
held at the Intercontinental Hotel and Conference Center in Addison, 

Texas. Classes will be held April 24 through 29, 2016. Over 1,000 
photographers attend Texas School and we look forward to another great 
year in 2016. The hotel, located north of Dallas, just off the North Dallas 
Toll Road, is the setting for this event.

The 523 room Intercontinental Hotel has agreed to a room rate of only $121, 
so more people will be able to stay at the host hotel. More information is 
available on the Texas School website at www.texasschool.org. You might 
want to go ahead and book your room because they will sell out fast.

Online registration for the 2016 Texas School begins at 11pm on January 3, 
2016. Last year the first class booked in only 3 seconds with several others 
within 2 minutes! If you’ve never experienced Texas School, you’ve missed 

Ross Benton		
Doug Box		
William Branson III		
Carl Caylor		
Tony Corbell		
Bry	 Cox		
Gregory & Lesa Daniel
Cris & Deanna Duncan
David & Luke Edmonson
Hanson Fong		
Beth Forester		
Dan Frievalt		

out on one of the best learning experiences available to photographers in the 
world. There will be at least 36 classes covering every topic imaginable and 
all are designed to help your business grow and be successful. In addition, 
we are going to repeat the Big Texas Shootout where every student will be 
able to practice what you have learned in class and compete for over $5000 
in prizes and cash.

As everyone knows, the photography industry is changing. You have to be 
on top of your game. Texas School offers everyone the best education in the 
country and at the most affordable prices. Along with classroom instruction, 
there is a fun and exciting social life at Texas School with parties, meal 
events, entertainment and an impressive trade show. Another good reason to 
attend is that all evening meals will be FREE, thanks to our many sponsors. 
So, mark your calendar now for April 24 - 29, 2016, and come and see what 
the “Texas School Experience” is all about.

Gary & Kathryn Meek
Sandra Pearce		
Sam Puc		
Thom Rouse		
Jim Schmelzer		
Marilyn Sholin		
Richard Sturdevant		
Woody Walters		
Billy Welliver & Mitch Daniels
Janice Wendt		
John Wilson		
Steve Winslow & Sophie Lane

2016 Texas School Instructors
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Each year the Texas Professional Photographers Association grants 
a number of scholarships to the Texas School of Professional 

Photography to be held at the Intercontinental Hotel and Conference 
Center in Addison, Texas. These scholarships are available to newcomers 
to the profession as well as photographers who have been in photography 
for several years and meet certain requirements. You may qualify!

Two types of scholarships are available. The first is a classroom 
scholarship that pays the week’s tuition to a class. To be eligible for 
this scholarship, you must be a member of TPPA by July 1, 2015, and 
you must renew your 2016 membership prior to attending the 2016 
Texas School. In addition, you must not have received a Texas School 
scholarship during the previous ten years. Also, you must not have 
been in photography for more than five years, or if you have been in 
photography for more than five years, you must have earned a minimum 
of 20 Fellowship Points from TPPA. The final requirement is that only 
one application per studio or firm will be accepted.

The second type of scholarship is a “Wrangler Scholarship.” To be 
eligible, you must be a current (2016) member of Texas PPA, have 

attended the Texas School in the past, willing to work, able to get along 
well with people, able to take directions well, must have a car, must have 
satisfactory computer skills, and must be available by 9 am on April 24, 
2016.

If you want to be a part of a very elite, fabulous, hard working group 
of people who are a very important part of the success of Texas School, 
and would like to be considered as a wrangler, then apply online today 
at https://www.texasschool.org/wrangler-application/ to obtain a Texas 
School Scholarship or Texas School Wrangler application.

If you have any questions, ask any of the trustees, talk to someone who 
has been a wrangler in the past, or contact Cindy Romaguera, 
at 504-799-9729 or email her at Cindy@Romaguera.com. Remember, 
a Wrangler Scholarship is a “working scholarship.” When you are 
a wrangler, you get very close to your instructor, classmates, other 
wranglers, and the Texas School staff.

Sign up now and check the website and this magazine for further Texas 
School updates. 

Scholarships Available
Texas School of Professional Photography

by 
Don Dickson





You can add variety to your commercial portfolio by producing sketches 
of existing photographs. Using practically any version of Adobe 

Photoshop, the options are endless and the tools provide a great amount of 
flexibility and creativity.

Like anything else in Photoshop, there is always more than just one way to 
do anything. But here are some simple steps you can use to get started.

Step #1 - Open an image in Photoshop (see illustration 1) and, using the 
Layer Palet, go ahead and duplicate the original layer. Anyone who has been 
working with Photoshop for any length of time realizes how important it is 
to keep an original version of the image on a layer to itself. 

One way to duplicate a layer and place it above the original layer is to go up 
to the top of the screen to the Layer menu and click on Layer>New>Layer 
via copy. However you decide to do it, Photoshop will make a new layer and 
place it above the original “background” layer and title it “layer 1.”

Step #2 - Desaturate the layer. Go to the Image menu at the top of your 
screen and select Adjustments and then Desaturate (Image>Adjustments>

Desaturate).  This step will completely remove any color from the image 
and it will appear as a black-and-white image (see illustration 2). 

Step #3 - Duplicate the layer you’ve just created and desaturated. You can 
do just as you did in Step #1 and use the Layer menu at the top of your 
screen and click on Layer>New>Layer via copy. Your new layer will appear 
on the Layers panel, just above the previous layer. 

Of course, there are shortcuts for such things. In Windows, you can press 
Ctrl+J to accomplish the same thing (Command+J on Mac). The new layer 
will be labeled “Layer 1 copy.”

Step #4 - Once that is done, you will need to “invert” the image. To do this, 
go to the Image menu at the top of the screen, choose Adjustments, and then 
choose Invert (Image> Adjustments>Invert). This will invert the brightness 
values in the black-and-white image and make it look like a negative (see 
illustration 3).

Step #5 - Next, you will need to change the blend mode of the inverted layer 
from Normal (which is the default setting) to Color Dodge. To do this, go to 

LAWRENCE MILLBARGE
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the Layers panel and look on the top-left of the panel. Click on the fly-out 
tab on the window and scroll down and select “Color Dodge.”

This will temporarily turn the image to white, so don’t be alarmed. 
Photoshop is essentially filling the image with white.

Step #6 - The next step is to apply the Minimum Filter. To accomplish this, 
go up to the top of the screen to Filter and choose Other and then Minimum. 
(Filter>Other>Minimum). A new dialog box will open with the default 
setting of one pixel. Just click OK to close the box.

The photo is immediately converted into a very detailed “sketch” of the 
original image (see illustration 4). However, you can modify that image by 
darkening the sketch lines and even adding color.

Step #7 - Next, merge the existing layers into one new layer while keeping 
the original layers (for backup or whatever). To accomplish this, go to the 
Layer panel and hold down the Alt key (Option in Mac). While still holding 
down the Alt (Option) key, click the fly-out menu on the (upper-right) of the 
Layer panel and scroll down and select Merge Visible. This will duplicate 
and merge the existing layers and place them on one layer above the existing 
layers.

Step #8 - We are now fine-tuning the image by changing the blend mode 
and adjusting the opacity to darken the lines in the sketch. With the recently 

created layer selected, go to the Layer panel and change the Blend Mode 
(window in upper-left of panel) from Normal to Multiply. If you think the 
sketch is too dark, you can lower the Opacity value (upper-right of panel) 
from 100% (default) down to 80% or whatever looks best (I set mine to 
80%). 

Step #9 - Add some color... if you want. To accomplish this, we will be 
using colors from the original image. Fortunately, we still have that original 
layer on the layer panel (if all steps have been followed). First, select the 
Background layer (will be highlighted on the panel). Then, make a copy 
of the Background layer by going to the top of your screen to Layers and 
choosing New and then selecting Layer via Copy (Layers>New>Layers via 
Copy). This will create a copy of the Background layer and place it directly 
above the original.

Step #10 - The next step is to move that newly-created copy of the 
Background layer to the top of all the other layers on the layer panel. 
You can “drag” it to the top of the heap or use a shortcut... Shift+Ctrl+] 
(Windows) or Shift+Command+] (Mac). This will instantly move that layer 
to the very top of all the other layers.

Step #11 - Finally, change the Blend Mode from “Normal” to “Color” and 
adjust the Layer Opacity. With the Background Copy layer selected on the 
Layer panel, change the Mode from Normal to Color (upper-left of Layer 
panel). This will “colorize” your sketch. At this point, you can lower or 

raise the Opacity as desired. 
In this example (see 
illustration 5 below), the 
Opacity was set to 90%.

Creating sketches from 
photographs is just another 
tool in the Photoshop 
arsenal that can help set 
your work apart from 
the competition. But this 
technique does not have to 
be limited to commercial 
photography. Try the same 
technique on a variety of 
images from your portfolio 
and see for yourself how 
they can create excitement 
and interest.
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“Made in America” - Mark McCall, of Lubbock, Texas, attends a lot of air shows, especially those that 
allow him to get “up close” to the aircraft. Although vintage aircraft are his favorites, he also enjoys 
watching aerial teams like the Air Force Thunderbirds, who were performing at Cannon Air Force Base 
in Clovis, New Mexico. Mark carts his equipment around in a mobile, four-wheel, plastic, sit-inside 
wagon (the type used to take a 3 year old to the beach). The wagon provides a nice step-up platform to 
see over crowds, a way of getting low level shots, and to haul lawn chairs. As Thunderbird #4 rolled 
by the crowd on his way to the flightline, Mark stood on his wagon to get a clear shot and captured the 
aircraft from less than 50 feet away using a Canon 5D MkII with a 70-200 lens. “Normally, I would not 
need this much resolution for a shot like this, but I didn’t expect to be able to get that close,” he says. 
In post-production, Mark removed the plane from the original background in Photoshop, retracted the 
landing gear, and replaced parts of the F16 that were hidden by the landing gear. Next, he cloned the 
F16 and placed it all against an image containing lots of clouds and blue sky, composing each plane in 
perfect formation. The image was placed in the PPA Loan Collection.
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Painting with light is a creative technique that can give your still-life 
photography a new dimension. Whether we realize it or not, we “paint 

with light” each time we take a photograph. We simply do it faster... in a 
fraction of a second. In essence, we “paint” whatever the lens sees in one 
quick stroke. But what if we could control each element of that image 
independently, manipulating the angle and intensity of the light that 
illuminates each of those elements?

Fortunately, this technique does not require a lot of equipment. You won’t 
need to spend a fortune on electronic flash and light stands. All you will 
basically need is a light 
source (even a flashlight), 
a sturdy tripod, a dark 
location, and a camera 
capable of long exposures. 
Digital cameras have made 
the process much easier 
and more efficient than in 
the days of film because 
you can view your results 
instantly and make any 
corrections as you go.

The “continuous” light 
source should be something 
you can easily manipulate 

and carry, such as a flashlight. Depending on the subject matter, you might 
select to use a small light or a larger and more powerful light. But a good, 
sturdy tripod is essential to the process and should prevent any movement 
of the camera during and between the long exposures. A dark location can, 
however, be the most difficult element. If you are photographing a rather 
small subject, a dark room in the studio or home is easy to find. If you are 
photographing a larger subject outdoors, finding a “dark” location can be a 
bit more tricky. Light sources such as streetlights, even at a distance, will 
illuminate portions of the location during long exposures. A passing car can 
ruin a shot.

In the image of the little 
yellow submarine, Eric 
wanted to make a whimsical 
recreation of the scene from 
when the hull was first rolled 
out of this same facility 
over 30 years ago. “I’m 
trying to imply a sort of Tom 
Sawyer / Huckleberry Finn 
feeling mixed with a Norman 
Rockwell flavor.” 

by
Bill Hedrick







Texas Professional Photographer  Oct/Nov 2015	 31

The steps of the process are relatively 
simple. First, set your camera on a tripod 
and take a sample image (lights on, 
daylight, etc.) to verify your composition. 
Next, set your shutter speed to a 
relatively long value and stop down the 
lens aperture as needed. Then, with your 
light in hand, turn off the lights and get started.

Some experimentation is recommended to determine how much “painting” 
you will need for each element of the image. But that’s the great thing about 
digital cameras... you can view what you’ve done in real time and “do it 
over” if necessary. How “precise” you want to be is strictly up to you.

With larger and more elaborate objects, you’ll normally need to make 
separate exposures for each element of the image and combine them later 
in Photoshop. In the old days of film, this process was done using separate 
exposures but using one piece of film. Back then, it was not possible to view 
the results of each exposure and you had to wait until that piece of film was 
processed to see the final results.

Perhaps some of the finest examples of “painting with light” can be found 
in the work of Eric Curry, a commercial photographer from California. Eric 
was an art graduate who worked as a professional photographer in Denmark 

for 12 years after graduating from the Art Center College of Design in 1980. 
His field of expertise was still-life and special effects. “Back then, I often 
used multiple 4x5 cameras to shoot multiple exposures on the same sheet of 
film to create what was then pretty complex shots for advertising. Without 
a large budget to work with, there was no money for fancy props or special 
effect models. So, most of the techniques I developed were out of necessity... 
smoke and mirrors,” Eric explains.

Returning to America in 1992, he began applying the lessons of lighting 
discipline, composition and studio special effects to the world of industrial 
location photography because it affords, as he comments, “A much broader 
pallet of avenues for creativity.” Today, he mostly photographs corporate 
aviation on location. He was using the “painting with light” technique 
30 years ago while photographing large jets for Scandinavian Airlines in 
Denmark but today he uses the technique primarily for his private shootings.  

“It is hard to use this technique to do a 
lot of commercial work because of the 
forces in the market place,” Eric explains. 
“Clients want a lot of views, from 
different angles, with different poses, 
etc. When shooting for myself, I like to 
put all the energy that we photographers 
would usually pour into all those different 

The photograph of the Navy hard suit was 
actually taken aboard the U.S. Navy’s 
“Kellie Chouest” just prior to an overseas 
deployment. “The shot is sort of a tribute to 
the history of navy divers,” Eric explains. 
“You can see the old fashioned brass hard 
hat sitting on the left side. The Navy agreed 
to bring that along from their facility in 
San Diego so we could include it in the 
photo.” The suit itself is the “Atmospheric 
Diving System 2000” which is made by 
OceanWorks in Vancouver, B.C. and is 
rated to a depth of 2,000 feet. There are 
apparently only four such suits in the world 
rated for that extreme depth and two of 
them are on the deck of this ship.

“Captain America,” tells a story of 
someone making amends for a youth 
misspent. The bike owner ponders an 
earlier life of supporting the wrong causes, 
self-absorption, and avoiding the draft. 
“After his spiritual awakening, it is now 
time to make amends in his own unique 
way. He is indeed a one-man traveling 
parade who is on a mission,” explains 
Eric. The small child included on the far 
left of the frame represents the innocence 
of our hero and the desire in us all.” Eric 
took this photograph, along with five 
volunteers, at The Rock Store, a popular 
dinner hangout for bikers and celebrity 
bikers, located in the mountains north of 
Los Angeles.



versions of a photograph into one single great image. There are no other 
versions, no different angles to choose from. I only have one shot. If it fails, 
well... that’s that. My philosophy in life and photography is that you make 
choices and live with the consequences.”

Several years ago, Eric Curry worked on a personal project he called 
“American Pride and Passion.” The concept was a result of his desire to 
literally give something back to this great country of ours. “The goal of 
highlighting everyday heroes hiding in plain sight seemed a worthy subject 
for this particular technique I had developed,” says Eric. “At the level of 
execution that I am practicing this style of photography, I am very selective 
of my subject matter because it is such a large commitment from myself and 
all of the volunteers who help make each shot.” Since “going public” with 
his project, Eric has already had two one-man museum shows of his work.

Each image in his American Pride and Passion series is an attempt to draw 
out the beauty and passion from everyday objects that come alive during 
one of his night-time, controlled lighting sessions. “By carefully composing 
and lighting these real-life objects, and 
with the help of volunteer photographic 
assistants, I’m striving to interpret them as 
metaphors for values of character, honor, 
integrity and pride, exemplified by the 
people who work with this equipment on 

a regular basis,” says Eric. “Through these photographs, I strive to share with 
the viewer the passions enjoyed by our fellow countrymen... whether laborer, 
professional, volunteer, corporate CEO or just a guy who owns a cool, old 
pickup truck. We all share this American experience together.”

He is often asked, and the question always gets a laugh, to list his favorite. 
“I have so many favorites because there are so many good memories of the 
people I meet and interact with on location during the course  of creating 
these photographs,” he explains. “Being able to interact with the people who 
are so  very passionate about what they do is inspirational to me. The life 
experience gained is a big part of my favorite list.”

On his website, AmericanPrideAndPassion.com, Eric provides detailed 
narratives of each of the images in his collection. Each image has a unique 
story of its own. Each photo is a unique and one-of-a-kind masterpiece. So, if 
you are looking for a way to motivate the artist within you and impress your 
clients, try it yourself.

Eric spotted this ‘56 Chevy at a local car 
show and was struck by the classic, almost 
iconic look of this restored automobile. 
“My initial inclination for the styling of 
the photograph we made together was to 
create something with a look and feel very 
much like American Graffiti. Similar to an 
advertisement for those burger joints of 
the 50’s and 60’s, with that sort of heavily 
airbrushed, illustrated flavor to them,” 
explains Eric. The location of this image 
was a nostalgic restaurant in Torrance, 
California. The restaurant manager is 
pictured in the far-right background. 
The carhop girl on skates is one of the 
hostesses of the restaurant.

Three of the crew members of this vintage 
B-25 are pictured in the shot outside the 
plane. The fourth person happened to be 
strolling by wearing vintage aviator attire 
while Eric was shooting that evening. 
After being quickly relieved of his cake 
and mixed drink, he was hustled up 
into the bombardier’s station with strict 
instructions to “freeze.” The dog, Emma, 
was a “mutt” Eric borrowed from one of 
the guests at the event. She was totally 
uncooperative during the first four tries at 
getting her to pose. Finally, at the end of 
the shooting session and after one last try 
at placing her on the seat, Emma just gave 
up and went to sleep. She looks great just 
lying curled up on the passenger seat.
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Contributors:   Heart of Texas - Tom Sergent;  Houston - Dixie Dobbins

Heart of Texas - The July meeting of the Heart of Texas Professional 
Photographer’s Guild’s had a schedule conflict and Tom Sergent was 
pressed into service as the speaker. Tom is currently working towards his 
Photographic Craftsman degree so it was a good opportunity for him to 
practice and to help the guild at the same time. Tom spoke on the topic 
of “Commercial Photography 101” to provide an overall view of the 
subject. He finished the program with a tour of a recent industrial job 
and explained how he handled some problems that presented themselves 
during the assignment.

In the July print competition, winners in the Professional Division were: 
Rhonda Williams, first place; Cecy Ayala, second place; and Shelly 
Taylor, third place. Winners in the Associate Division were: Darrell 
Vickers, first place; Billy Lauderdale, second place; and Tim Williams, 
third place. Winners in the People’s Choice Division were: Rhonda 
Williams, first place; Luke Stokes, second place; and Billy Lauderdale, 

third place. The July meeting also had a Challenge Competition called 
“Stop Action Photography.” Winners were: Darrell Vickers, first place; 
Billy Lauderdale, second place; and Rhonda Williams, third place.

The August meeting was held at Coach’s Smokehouse, a new location 
in Waco. Guest speaker was Greg Phelps who made the trek all the way 
from the valley to present a program on “Pricing Your Work.” Using his 
approach to pricing, a beginning “pro” photographer or an established 
one can easily figure how to price their work and make their prices fit 
their demographic area and client base. Greg also provided directions on 
downloading it from a website to use in your own studio.

August winners in the Professional Division were: Cecy Ayala, first 
place; Rhonda Williams, second place; and Luke Stokes, third place. 
Associate Division winners were: Rick Duhrkopf, first place; and Darrell 
Vickers, second place. People’s Choice winners were: Luke Stokes, 
first place; Jill Hubbert, second place; and Rick Duhrkopf, third place. 
There was also a Black and White competition with the parameters of 
using only available light. Winners were: Darrell Vickers, first place; Jill 
Hubbert, second place; and Rhonda Williams, third place.

Houston - At the July meeting of the Professional Photographers Guild 
of Houston, Bree Adams presented a workshop and program on making 
maternity and newborn portraits. She discussed her background, style 
of photography, the experience she creates for her clients, and how she 
markets her photography to new clients.

At that July meeting, there was a large turnout for the image competition. 
Winners in the Master’s Division were: Karen Butts, first place; Cat 
Dybala, second place; and Aileen Harding, third place. Winners in the 
Active Division were: Sherry Piche, first and third places; and Curley 
Marshall, second place.

Also in July, Nikki LaWell presented a half-day workshop called 
“Polished Presentations Produce Profitable Portraits.”

Articles for Magazine - If you have an article of interest to our 
readers, why not submit it to the Texas Professional Photographer? 
Photographers of all skill levels have something of interest to others. You 
don’t have to be a professional writer to submit an article for publication. 
Just write it in your own words and let us do the rest.

Information on submitting an articles for publication in the magazine 
can be found on the magazine website at TexasProPhotoMagazine.com. 
If your article is published, you will receive points toward your TPPA 
Fellowship degree. Try it... we’ll make you famous!
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